
 
 

ՔԱՐՏԵԶԱԳՐՈՒԹՅԱՆ 
ՀԻՄՈՒՆՔՆԵՐ 

Առարկայական ծրագիր 

Ներածություն տարածական տվյալների և քարտեզագրության մասին (1 ժամ դասախոսություն) 

● Տերմինների սահմանումներ (Քարտեզներ, քարտեզագրում, աշխարհագրություն, 
աշխարհագրական տվյալներ, տարածական տվյալներ) 

● Քարտեզագրության և դրա կիրառությունների ակնարկ 

Քարտեզագրման Պատմություն  (3 ժամ դասախոոսություն) 

● Վաղ քարտեզներ և քարտեզագրություն 

● Քարտեզագրության պատմության հիմնական զարգացումները 

Քարտեզների տեսակներըs (3 ժամ դասախոոսություն) 

● Ֆիզիկական, քաղաքական, թեմատիկ քարտեզներ, տեղագրական քարտեզներ 

Քարտեզի տարրերը (3 ժամ դասախոոսություն, 1 ժամ գործնական աշխատանք) 

● Պիտակներ, ծանոթագրություններ, խորհրդանիշներ և դրանց նշանակությունը, լեգենդներ 
և մասշտաբի սանդղակներ 

Քարտեզի պրոյեկցիա և կոորդինատային համակարգ (2 ժամ դասախոոսություն, 2 ժամ 
գործնական աշխատանք) 

● Քարտեզի պրոյեկցիայի տեսակները 

● Աղավաղումները և դրանց հետևանքները 

● Գեոդեզիական և քարտեզային կոորդինատային համակարգ 

Տարածական տվյալների ձեռքբերման մեթոդներ(2 ժամ դասախոոսություն, 2 ժամ գործնական 
աշխատանք) 

● Հողային հետազոտության տեխնիկա, GNSS և հեռազննման հիմունքներ 

● Աերոլուսանկարներ, արբանյակային պատկերներ, LiDAR (լույսի հայտնաբերում և 
տիրույթի որոշում) 

Քարտեզների օգտագործումը (3 ժամ գործնական աշխատանք) 

● Քարտեզների ընթերցում և մեկնաբանում 

● Քարտեզով կողմնորոշման հմտություններ 

● Քարտեզների կիրառությունը տարբեր ոլորտներում (օրինակ՝ քաղաքաշինություն, 
բնապահպանական կառավարման ոլորտում) 

 
Տնային աշխատանքը կներառի՝ 20 ժամ գրականության վերլուծություն, տերմինաբանության 
քարտեզագրում և անհատական ուսումնասիրություն։ 
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Նպատակներ և կարողություններ 

Դասընթացի նպատակները 

● Տարածական տվյալների և քարտեզագրման վերաբերյալ հիմնարար գիտելիքներ 
տրամադրել։ 

●  Ուսանողներին ծանոթացնել քարտեզների տարբեր տեսակների և դրանց կիրառման հետ։ 

● Սովորեցնել կոորդինատային համակարգերի և քարտեզագրական պրոյեկցիաների 
սկզբունքները։ 

● Ուսումնասիրել քարտեզագրման պատմությունն ու զարգացումը։ 

● Ուսանողներին ծանոթացնել տարածական տվյալների ձեռքբերման մեջ օգտագործվող 
մեթոդներին և տեխնոլոգիաներին։ 

Կարողություններ՝ 

● Համապատասխան խորհրդանիշների և պիտակների միջոցով քարտեզներ մեկնաբանելու 
և ստեղծելու ունակություն։ 

●  Կոորդինատային համակարգերի ըմբռնում և քարտեզագրական պրոյեկցիաներ 
կիրառելու ունակություն։ 

●  Քարտեզների տարբեր տեսակների և դրանց հատուկ կիրառությունների իմացություն։ 

● Տարածական տվյալների ձեռքբերման հիմնական տեխնիկաների տիրապետում։ 
 

Նախատեսված ուսումնական արդյունքները 

Դասընթացը հաջողությամբ անցած ուսանողները կկարողանան 

● Բացատրել տարածական տվյալների և քարտեզագրման հիմնարար հասկացությունները։ 

● Ճանաչել և օգտագործել տարբեր տեսակի քարտեզներ և դրանց տարրերը (պիտակներ,  
խորհրդանիշներ)։ 

● Նկարագրել քարտեզագրման պատմությունը և զարգացումը։ 

● Կիրառեք կոորդինատային համակարգեր և քարտեզագրական պրոյեկցիաներ։ 

● Տարբերակել տարածական տվյալների ձեռքբերման տարբեր մեթոդները։ 

● Արդյունավետորեն օգտագործել քարտեզները տարբեր կիրառությունների համար։ 

Դասընթացի բովանդակությունը 

Տարածական տվյալների և քարտեզագրման ներածություն 

Աշխարհագրությունը ուսումնասիրում է վայրերը, լանդշաֆտները, միջավայրերը, ինչպես նաև 
մարդկանց և նրանց միջավայրի միջև եղած փոխհարաբերությունները։ 
Տվյալները փաստեր և վիճակագրական ցուցանիշներ են, որոնք հավաքագրված են հղման կամ 
վերլուծության նպատակով։ 
Տարածական տվյալները տվյալներ են, որոնք ընդգրկում են մեկից ավելի տարածական 
չափումներ (2D, 3D և այլն)։ 
Երկրագրական տվյալները (կարճ՝ գեոդատա) տվյալներ են, որոնք ներկայացնում են Երկրին 
առնչվող հատկություններ կամ երևույթներ։ 
Քարտեզը երկրի մակերևույթի կամ նրա մի հատվածի փոքրացված և պարզեցված պատկեր է։ 
Քարտեզագրումը տվյալ համատեքստում նշանակում է քարտեզի կազմման գործընթաց։ 
Ուշադրություն դարձրեք, որ այս բառը կարող է ունենալ տարբեր նշանակություններ տարբեր 
ոլորտներում, օրինակ՝ մաթեմատիկայում։ 
Քարտեզագրումը կարելի է նկարագրել նաև որպես աշխարհագրական տվյալների տեսողական 
ներկայացումներ ստեղծելու գործընթաց, որը հում փաստերն ու վիճակագրությունը վերածում է 



հասկանալի, տարածականորեն կազմակերպված տեղեկատվության: Այն անգնահատելի է 
աշխարհագրությունն ուսումնասիրելու համար, քանի որ այն օգնում է պատկերել մարդկանց, 
վայրերի և միջավայրերի միջև փոխհարաբերությունները: Տարածական տվյալները և 
աշխարհագրական տվյալները քարտեզների տեսքով ներկայացնելով՝ քարտեզագրումը 
հեշտացնում է Երկրի առանձնահատկությունների և երևույթների վերլուծությունն ու 
մեկնաբանումը: Քարտեզագրման կիրառությունները բազմազան են, ներառյալ 
քաղաքաշինությունը, շրջակա միջավայրի պահպանումը, տրանսպորտային լոգիստիկան, 
աղետներին արձագանքումը և ռեսուրսների կառավարումը, որոնք բոլորն էլ օգտվում են բարդ 
աշխարհագրական տվյալների հստակ և մատչելի պատկերացումներից: 

Առաջադրանք 

համապատասխանեցրեք տերմինը դրա նկարագրությանը 
 

քարտեզ Երկրի մակերևույթի կամ այդ մակերևույթի մի մասի փոքրացված կամ 
պարզեցված պատկեր 

քարտեզագրում Քարտեզի ստեղծման գործընթացը 

Տարածական 
տվյալներ 

տվյալներ, որոնք ընդգրկում են մեկից ավելի տարածական չափումներ 

աշխարհագրու
թյուն 

վայրերի, լանդշաֆտների, միջավայրերի և մարդկանց ու նրանց 
միջավայրերի միջև փոխհարաբերությունների ուսումնասիրություն 

Աշխարհագրակ
ան տվյալներ 

Երկրի հետ կապված առանձնահատկություններ կամ երևույթներ 
ներկայացնող տվյալներ 

 

Քարտեզագրության պատմություն 

Մենք արդեն սովորել ենք քարտեզի սահմանումը։ Բայց ինչպե՞ս տարբերակել քարտեզը 
հատակագծից, ուրվագծից կամ պարզ գծագրից։ Սա բավականին փիլիսոփայական հարց է։ 
Հայտնի է, որ մարդիկ քարտեզներ (կամ հատակագծեր, աշխարհագրական ուրվագծեր և այլն) 
նկարում էին դեռևս «քարտեզ» բառի ներմուծումից շատ առաջ։ Այս ամենահին մասունքներից 
մեկը, որը մենք կարող ենք անվանել քարտեզ, մամոնտի ժանիքի վրա փորագրությունն է՝ 
հարավային Մորավիայի Թայա գետի ոլորապտույտների հատակագիծը, որը նույնպես 
պատկերում է բնիկ ժողովրդի ճամբարը։ Այս փորագրությունը, հավանաբար, թվագրվում է 
պատմության մեջ առնվազն 20 000 տարի առաջ։ 

 
Մամոնտի ժանիքների փորագրման քարտեզ, Պետր Նովակ, Վիքիպեդիա 



 
Շատ հին քարտեզի (կամ «քարտեզի») նշանակալի օրինակներից մեկը այսպես կոչված 
«Մապպա դի Բեդոլինան» է՝ ամենավաղ քարտեզներից մեկը, որը պահպանվել է մինչև մեր 
օրերը: Ինչպես մյուս շատ հին քարտեզների դեպքում, դրա իրական տարիքը դժվար է ասել՝ 
անհայտ ծագման ամսաթվի պատճառով: Ենթադրվում է, որ այն ստեղծվել է մ.թ.ա. մոտ 1000 
թվականին: «Մապպա դի Բեդոլինան» Լոմբարդիայի Բեդոլինա քաղաքի շրջակայքի 4 մետր 
երկարությամբ հատակագիծ է: Այսքան հին քարտեզի մեկ այլ օրինակ է բաբելոնյան Նիպուր 
քաղաքի քաղաքային հատակագիծը: 

 
Mappa di Bedolina, Luca Giarelli / CC-BY-SA 3.0 

 



Բաբելոնյան Նիպուր քաղաքի քարտեզը։ https://imgur.com/map-of-babylonian-city-of-nippur-ca-

1500-bce-this-is-earliest-known-city-map-drawn-to-scale-lWuI7RR 

 
Եթե վերոնշյալ հին քարտեզները մասշտաբ ունենային, մենք կարող էինք դրանք բոլորը անվանել 
մեծ կամ միջին մասշտաբի քարտեզներ. դրանք ընդգրկում էին Երկրի մակերևույթի միայն մի 
փոքր մասը։ Դա պայմանավորված է նրանով, որ դրանց հեղինակներին հայտնի տարածքը 
բավականին սահմանափակ էր։ Այդ ժամանակվանից ի վեր, մարդկային բնակչության աճի և հին 
քաղաքակրթությունների ընդլայնման հետ մեկտեղ, ի հայտ են եկել ավելի մեծ տարածքներ 
ընդգրկող քարտեզներ։ Այս քաղաքակրթությունների կողմից Երկրի անընդհատ հայտնաբերման 
արդյունքում ստեղծվել են հայտնի աշխարհի առաջին քարտեզները։ 
Հատկանշական է Անաքսիմանդրոսի աշխարհի քարտեզը։ Իրական քարտեզը չի պահպանվել 
մինչև մեր օրերը, բայց հայտնի է, որ դրա ձևն ու դիզայնը ազդել են հետագայում ստեղծված 
բազմաթիվ քարտեզների վրա։ Մենք դրանք անվանում ենք «կլոր քարտեզներ», քանի որ դրանք 
ունեն շրջանաձև ձև։ 
Այդ քարտեզներից մեկը, որը պահպանվել է մինչև մեր օրերը, Հերեֆորդ Մունդիի քարտեզն է, 
որը ստեղծվել է մոտ 1280 թվականին։ Այն պատկերում է հայտնի մայրցամաքներ՝ Եվրոպա, 
Ասիա և Աֆրիկա։ Քարտեզի կենտրոնում Երուսաղեմն է, և այն կողմնորոշված է այնպես, որ 
արևելքը քարտեզի վերևում է, իսկ հյուսիսը՝ ձախ կողմում։ Հերեֆորդ Մունդիի քարտեզը 
պատկերում է արևելքում գտնվող Գանգես գետից մինչև արևմուտքում գտնվող Ջիբրալթարի 
նեղուցը և հյուսիսում գտնվող Բալթիկ ծովից մինչև հարավում գտնվող Նեղոս գետը։

 
Անաքսիմանդրոսի աշխարհի քարտեզը։ Հավանական վերակառուցում։ 
 



 
.Հերեֆորդ Մապպա Մունդի։ 
 
Հին «աշխարհի» քարտեզների արևելյան կողմնորոշումը բնորոշ էր, քանի որ արևելքը 
համարվում էր դեպի երկինք ուղղվածություն: Քարտեզների հյուսիսային կողմնորոշումը, որն 
այսօր տարածված է, ի հայտ եկավ ավելի ուշ: Միջնադարյան քարտեզները, որոնք կոչվում էին 
պորտոլանական քարտեզներ, օգտագործում էին հյուսիսային կողմնորոշումը: Այս քարտեզները 
ստեղծվել են 13-րդ դարից սկսած: Դրանց նպատակը ծովային նավարկությունն էր: Դրանք 
հայտնի են ափագծերի ճշգրիտ պատկերմամբ և այն փաստով, որ լոքսոդրոմները 
(անկյունագծային գծեր) քարտեզի վրա ցուցադրվում են որպես ուղիղ գծեր: Այս պորտոլանական 
քարտեզներից ամենահինը հայտնի է Carta Pisana-ով: 



 
Քարտա Պիզանա։ Պահպանված կտորը։ 
 
15-րդ դարի վերջին Մարտին Բեհայմը ստեղծեց իր գլոբուսը՝ Երկրի մակերևույթի գնդաձև 
պատկերը։ Սա առաջին ստեղծված գլոբուսը չէր, հայտնի է, որ գնդերը գոյություն են ունեցել նաև 
անտիկ ժամանակներում, բայց Մարտին Բեհայմի գլոբուսը մինչ օրս պահպանված ամենահին 
գլոբուսն է։ 
 



 
«Էրդապֆել»- Մարտին Բեհեյմի գլոբուսը։ 
https://commons.wikimedia.org/wiki/File:Behaims_Erdapfel.jpg 
 
16-րդ դարում քարտեզագրության վրա զգալի ազդեցություն է ունեցել մաթեմատիկոս Գերհարդ 
Մերկատորը։ Մերկատորը ստեղծել է մի շարք քարտեզներ, գլոբուսներ և ատլասներ։ Նա նաև 
համարվում է «ատլաս» բառի հեղինակը քարտեզագրական իմաստով՝ քարտեզների 
հավաքածու, որոնք ունեն նմանատիպ կազմ և արտացոլում են որոշակի ընդհանուր թեմա կամ 



նկարագրում են որոշակի տարածաշրջան։ Գերհարդ Մերկատորը նաև հիմք է դրել 
մաթեմատիկական քարտեզագրության ոլորտին (ավելին մաթեմատիկական 
քարտեզագրության մասին՝ «Քարտեզների պրոյեկցիաներ և կոորդինատային համակարգեր» 
գլխում)։ 
 
Քարտեզագրության հետագա զարգացումները մեծապես ազդվեցին տպագրական մեքենաների 
գյուտից և տպագրական տեխնիկայի ընդլայնումից։ Տպագրությունը զգալիորեն հեշտացրեց 
քարտեզների վերարտադրությունը։ Մինչ այդ քարտեզները ձեռքով վերանկարվում էին մաս առ 
մաս, ինչը յուրաքանչյուր քարտեզ դարձնում էր փաստացի ինքնատիպ։ 
 
Քարտեզները դարերի ընթացքում ավելի մեծ ճշգրտություն ձեռք բերեցին չափման տեխնիկայի 
կատարելագործմանը և Երկրի ձևի ու չափի ըմբռնման զարգացմանը զուգընթաց: 16-րդ դարում 
Երկրի միջօրեականի առաջին չափումները (կոչվում են «աղեղային չափում») կատարվեցին 
Ֆրանսիայում. Փարիզից Ամիեն հեռավորությունը չափելու համար օգտագործվել է կառքի 
պտտվող անիվի պտույտների հաշվարկման տեխնիկա: Այնուհետև հաշվարկվել է ամբողջ 
միջօրեականի (և Երկրի) շրջագիծը: 17-րդ դարում աստղադիտակի գյուտը թույլ տվեց 
գեոդեզիստներին ճշգրիտ չափել հեռավոր մարմինների միջև անկյունները, իսկ եռանկյունացում 
կոչվող տեխնիկան հնարավորություն տվեց հաշվարկել հեռավոր մարմինների միջև 
հեռավորությունները: «Աղեղային չափումները» հետագայում կրկնվեցին 18-րդ դարում՝ ավելի 
ժամանակակից չափիչ սարքերով և եռանկյունացման տեխնիկայի կիրառմամբ 
Էկվադորում/Պերուում և Լապլանդիայում, ինչը հետագայում բարելավեց Երկրի շրջագծի 
հաշվարկը: 
1791 թվականին մետրը պաշտոնապես սահմանվեց որպես հեռավորությունների չափման 
հիմնական միավոր, ինչը նաև նպաստեց քարտեզների ճշգրտության բարելավմանը: 18-րդ 
դարում Յոզեֆ Լիսգանգը կատարեց կարևոր եռանկյունաչափական չափումներ՝ գեոդեզիական 
կետերի պատշաճ կայունացմամբ: Նրա կողմից կատարված միջօրեական աղեղի չափումը 
ձգվում էր Մորավիայից (Չեխիա) մինչև Խորվաթիա: 



Առաջին ճանապարհային ատլասը, որը կոչվում է «Բրիտանիայի ատլաս», ստեղծվել է Ջոն 
Օգիլբիի կողմից 17-րդ դարում։

 
Ջոն Օգիլբիի «Բրիտանիայի ատլասը»։ Լոնդոնից դեպի Բրիստոլ տանող ճանապարհը։ 
 
Առաջին քարտեզը հավասար գծերով ստեղծվել է Էդմոնդ Հալլիի կողմից: Հավասար գծերը գծեր 
են, որոնք միացնում են որոշակի երևույթի նույն արժեք ունեցող վայրերը: Հալլիի քարտեզը 
պատկերում էր մագնիսական տատանում: Հավասար գծերի մեթոդը հետագայում 
ժողովրդականություն ձեռք բերեց: Ալեքսանդր ֆոն Հումբոլդտը օգտագործեց հավասար գծերը՝ 
հավասար չափավոր ջերմաստիճան ունեցող վայրերը ցույց տալու համար, այդպիսով ստեղծելով 
առաջին քարտեզը իզոթերմներով: Այնուհետև Ֆիլիպ Բուաշը ստեղծեց Ֆրանսիայի քարտեզ, 
որի վրա առաջին անգամ օգտագործվեցին ուրվագծեր՝ հավասար բարձրություն ունեցող 
վայրերը միացնող հավասար գծեր: Բուաշի նորարարությունից առաջ քարտեզների վրա 
բարձրությունը ցույց էր տրվում «բլուրների» կամ «անտառների» պարզ մեթոդով, կամ 
թեքությունը պատկերվում էր շեղումներով: 
 



 
Էդմոնդ Հալլիի նոր և ճիշտ քարտեզը, որը ցույց է տալիս կողմնացույցի տատանումները 
 
Քարտեզագրական աշխատանքների վրա ազդեցություն ունեցավ մեկ այլ նշանակալի 
զարգացում. գունավոր տպագրության գյուտը 18-րդ դարում։ 
 
Նշանակալի գունագեղ քարտեզ է Ուիլյամ Սմիթի 1851 թվականի երկրաբանական քարտեզը: 
Երկրաբանական քարտեզներ ստեղծվել են նաև նախկինում, բայց սա այսօրվա 
երկրաբանական քարտեզների հիմքն է: 
 



 
Ուիլյամ Սմիթի երկրաբանական քարտեզը. https://www.nhm.ac.uk/discover/first-geological-map-
of-britain.html 
 
Պիեռ Շառլ Ֆրանսուա Դյուպենը առաջին ժամանակակից վիճակագրական քարտեզի հեղինակն 
է։ Այն պատկերում է Ֆրանսիայում կրթությունն ու գրագիտությունը և հրատարակվել է 1826 
թվականին։ Դյուպենի կողմից օգտագործված մեթոդը՝ շրջանները գունավորելը հարաբերական 
արժեքի հիման վրա տարբեր գույնի երանգներով, հայտնի է որպես խորոպլեթ քարտեզ։ 
Այնուհետև Դյուպենը ստեղծեց Ֆրանսիայի ավելի շատ վիճակագրական քարտեզներ այլ սոցիալ-
տնտեսական երևույթների համար՝ օգտագործելով թեմատիկ քարտեզագրության այլ մեթոդներ, 
ինչպիսիք են աստիճանական խորհրդանիշները։ 



 
Պիեռ Շառլ Ֆրանսուա Դյուպենի վիճակագրական (քորոպլեթ) քարտեզը։ 
https://www.researchgate.net/publication/269498551 
 
Մի քանի տարի անց՝ 1854 թվականին, Ջոն Սնոուն ստեղծեց իր հայտնի կետային քարտեզը։ Այս 
քարտեզը ցույց է տալիս խոլերայի դեպքերը Լոնդոնում հիվանդության բռնկման ժամանակ՝ 
որպես առանձին կետեր։ Ստեղծվելիս այն օգնեց տեղորոշել թունավորված ջրհորները և 
նույնիսկ բացահայտեց ջրհորների և հիվանդության դեպքերի միջև տարածական կապը։ Այդ 
խոլերայի դեպքը և Ջոն Սնոուի կատարած աշխատանքը համարվում են 
համաճարակաբանության հիմունքներ։ 



 
Ջոն Սնոուի քարտեզը «Խոլերայի հաղորդակցման եղանակի մասին» գրքից 
 
Թեմատիկ քարտեզներ ստեղծելու նորարարական մոտեցումը 1869 թվականին ներկայացրեց 
Չարլզ Ժոզեֆ Մինարդը։ Նա Նապոլեոնի արշավանքը Ռուսաստանի դեմ պատկերեց որպես մեկ 
գիծ, որը փոխում է իր խտությունը։ Խտությունը ներկայացնում է Նապոլեոնի բանակի 
զինվորների թիվը տվյալ վայրում և ժամանակում։ Այս տեսակի քարտեզը հետագայում 
անվանվեց հոսքի քարտեզ, և Մինարի քարտեզը առաջիններից մեկն էր։ 



 
Շառլ Մինարդի 1812 թվականի Նապոլեոնի Ռուսաստանի դեմ արշավանքի քարտեզը։ 
 
18-րդ դարի կեսերից մինչև 19-րդ դարի կեսերը Եվրոպայում ստեղծվել են բազմաթիվ 
կադաստրային քարտեզներ: Այս մանրամասն հողային քարտեզները հաճախ հիմնված էին շատ 
ճշգրիտ գեոդեզիական չափումների վրա, մասնավորապես Ավստրո-Հունգարիայում: 
Կադաստրային քարտեզների հետ մեկտեղ ստեղծվել են նաև ռազմական նպատակներով 
նախատեսված մանրամասն քարտեզներ: 

Առաջադրանք 

Ճանաչե՛ք հետևյալ նշանակալի հին քարտեզները՝ 

⚫ Բեդոլինայի քարտեզը 

⚫ Ջոն Սնոուի կետային քարտեզը 

⚫ Հերեֆորդի քարտեզը 

⚫ Պիեռ Ս. Ֆ. Դյուպենի վիճակագրական քարտեզը 

 



 
 

Քարտեզների տեսակները 

Քարտեզները կարելի է բաժանել երկու հիմնական խմբի՝ հղման (բազային) քարտեզներ և 
թեմատիկ քարտեզներ: Հղման և թեմատիկ քարտեզների միջև հիմնական տարբերությունը 
կայանում է դրանց նպատակի և փոխանցվող տեղեկատվության մեջ: 
Բազաին քարտեզները նախատեսված են աշխարհագրական առանձնահատկությունների, 
ինչպիսիք են սահմանները, քաղաքները և ֆիզիկական լանդշաֆտները, դիրքը ցույց տալու 
համար՝ ապահովելով տարածքի դասավորության ընդհանուր պատկերացում։ Օրինակներ են 
քաղաքական, ֆիզիկական և տեղագրական քարտեզները։ 
Ի տարբերություն դրա, թեմատիկ քարտեզները ընդգծում են որոշակի թեմա կամ թեմա 
աշխարհագրական տարածքում, ինչպիսիք են ջերմաստիճանը, բնակչության խտությունը կամ 
ռեսուրսների բաշխվածությունը՝ այս տվյալները համադրելով բազային քարտեզի վրա: Մինչդեռ 
բազային քարտեզները շեշտը դնում են տեղանքների և սահմանների վրա, թեմատիկ 
քարտեզները կենտրոնանում են որոշակի թեմայի հետ կապված օրինաչափությունների կամ 
միտումների հաղորդակցման վրա: 
 
Ֆիզիկական քարտեզները նախատեսված են Երկրի բնական լանդշաֆտային 
առանձնահատկությունները ցույց տալու համար։ Դրանք առավել հայտնի են տեղագրությունը 
գույներով կամ ստվերավորված ռելիեֆով ցույց տալու համար։ 



 
Հյուսիսային Ամերիկայի ֆիզիկական քարտեզ, Mapswire / CC-BY 4.0 
 
Քաղաքական քարտեզները ամենատարածված քարտեզներից են։ Դրանք ցույց են տալիս 
կառավարական միավորների, ինչպիսիք են երկրները, նահանգները և շրջանները, միջև 
աշխարհագրական սահմանները։ Կառավարական միավորները տարբերակելու համար 
յուրաքանչյուր միավոր ներկված է տարբեր գույնով։ Քաղաքական քարտեզները կարող են ցույց 
տալ ճանապարհներ, քաղաքներ և հիմնական ջրային օբյեկտներ, ինչպիսիք են օվկիանոսները, 
գետերը և լճերը։ Քաղաքական քարտեզները օգնում են մարդկանց հասկանալ աշխարհի 
աշխարհագրությունը։ Դրանք փակցված են դասարանների պատերին ամբողջ աշխարհում և 
սովորաբար դրանք քարտեզի առաջին տեսակն են, որին աշակերտները ծանոթանում են 
դպրոցում։ 



 
Հյուսիսային Ամերիկայի քաղաքական քարտեզը. 
https://www.burningcompass.com/continents/north-america/north-america-political-map.html 
 
Տեղագրական քարտեզները հղման քարտեզներ են, որոնք ցույց են տալիս Երկրի մակերևույթի 
ձևը: Դրանք սովորաբար դա անում են հավասար բարձրության գծերով, որոնք հայտնի են 
որպես «կոնտուրային գծեր», բայց բարձրությունը կարող է ցույց տրվել նաև գույների (երկրորդ 
քարտեզ), գունային գրադիենտների, ստվերավորված ռելիեֆի և մի շարք այլ մեթոդների 
միջոցով: Տեղագրական քարտեզները ցույց են տալիս նաև այլ կարևոր բնական 
առանձնահատկություններ, ինչպիսիք են լճերը, գետերը և առվակները: Տեղագրական 
քարտեզների վրա ցույց են տրված նաև կարևոր մշակութային առանձնահատկություններ: 
Դրանք ներառում են ճանապարհներ, արահետներ, շենքեր, տեղանուններ, նստարաններ, 
գերեզմանատներ, եկեղեցիներ, դպրոցներ և շատ ավելին: Այս օգտագործման համար մշակվել է 
հատուկ խորհրդանիշների ստանդարտացված հավաքածու: Տեղագրական քարտեզները 
ավանդաբար տպագրվել են թղթի մեծ թերթիկների վրա, որոնց չորս սահմանները 
երկայնության և լայնության գծերն են: 



 
Խորհրդային ռազմական քարտեզագրություն՝ Էլբրուս լեռան տեղագրական քարտեզ։ 
https://maps.vlasenko.net/smtm100/k-38-013.jpg 
 
Օրթոֆոտոքարտեզը բարձր թույլտվությամբ օդային լուսանկար է, որը երկրաչափորեն շտկվել 
կամ «օրթորեկտիֆիկացվել» է, որպեսզի այն ճշգրիտ ներկայացնի Երկրի մակերևույթը՝ ամբողջ 
մակերեսով միատարր մասշտաբով: Ի տարբերություն ստանդարտ օդային լուսանկարների, 
որոնք կարող են աղավաղումներ ունենալ տեսախցիկի անկյունների, տեղանքի կամ 
բարձրության պատճառով, օրթոֆոտոքարտեզները համընկնում են քարտեզի որոշակի 
պրոյեկցիայի հետ, ինչը թույլ է տալիս ճշգրիտ չափումներ կատարել հեռավորության, մակերեսի 
և անկյունների վրա անմիջապես պատկերից: Այս քարտեզները համատեղում են լուսանկարի 
տեսողական մանրամասները քարտեզի տարածական ճշգրտության հետ, ինչը դրանք 
օգտակար է դարձնում քաղաքաշինության, շրջակա միջավայրի մոնիթորինգի և 
աշխարհագրական վերլուծության ոլորտներում կիրառությունների համար: 



 
Չեխիայի քաղաքի օրթոֆոտո քարտեզը։ 
 
Թեմատիկ քարտեզը քարտեզի տեսակ է, որը պատկերում է որոշակի առարկայի (թեմայի) 
աշխարհագրական պատկերը աշխարհագրական տարածքում: Սա սովորաբար ներառում է 
քարտեզի խորհրդանիշների օգտագործումը՝ բնականորեն տեսանելի չհանդիսացող 
աշխարհագրական առանձնահատկությունների ընտրված հատկությունները, ինչպիսիք են 
ջերմաստիճանը, լեզուն կամ բնակչությունը, պատկերացնելու համար: 



 
Թեմատիկ (քորոպլեթ) քարտեզ, որը պատկերում է սևամորթների և լատինոամերիկացիների 
համամասնությունը Միացյալ Նահանգներում 2010 թվականի դրությամբ։. Bplewe / CC-BY-SA 4.0 
 
Այս դասախոսությունների համար աղբյուր: https://geology.com/maps/types-of-maps 

Առաջադրանք 

Քարտեզները դասակարգեք ըստ պատկերի 
⚫ Օրթոֆոտո 
⚫ Քաղաքական քարտեզ 
⚫ Ֆիզիկական քարտեզ 
⚫ Տեղագրական քարտեզ 
⚫ Թեմատիկ քարտեզ 

https://geology.com/maps/types-of-maps


Թ

 



Map ElementsՔարտեզի տարրերը 
Ճիշտ քարտեզը բաղկացած է առնվազն հետևյալից. 

● Քարտեզի նկար 

● Վերնագիր 

● Մասշտաբ 

● Պայմանական նշաններ 

● Քամու ուղղության հյուսիսի նշան 

● տպագրություն 
Սրանք այսպես կոչված կոմպոզիցիոն տարրերն են, և միասին դրանք կազմում են քարտեզի 
դասավորություն, որը հայտնի է նաև որպես քարտեզի կոմպոզիցիա։ 
Մենք ուսումնասիրելու ենք քարտեզի օրինակ և այն բաժանելու ենք առանձին տարրերի։ 
 

 
Համապատասխան բաղադրիչներով քարտեզ՝ քարտեզի պատկեր, վերնագիր, մասշտաբ, լեգենդ, 
տպագրություն և հյուսիսային սլաք։ 
 
.Քարտեզի պատկերը ամբողջ քարտեզի հիմնական մասն է։ Այն տարածական տվյալներ են, 
որոնք մեկնաբանվում են որոշակի քարտեզագրական տեխնիկայով՝ տեղեկատվություն, ուղերձ 
կամ տեսակետ փոխանցելու համար։ Սակայն քարտեզի պատկերն ինքնին չի կարող որևէ 
իմաստալից տեղեկատվություն փոխանցել։ Ինչպես կարող եք տեսնել ստորև բերված նկարում, 
եթե քարտեզի պատկերը չի ուղեկցվում այլ տարրերով, քարտեզի բովանդակությունը կլինի 
զուտ ենթադրություն։ 



 
.Քարտեզի պատկեր՝ առանց որևէ այլ կոմպոզիցիոն տարրերի։ 
 
Քարտեզի բովանդակությունը հասկանալու համար քարտեզի ընթերցողին օգնող առաջին 
տարրը վերնագիրը է։ Վերնագիրը պետք է լինի կարճ, բայց նաև նկարագրական և կոնկրետ։ 
Սովորաբար, քարտեզի վերնագրում «քարտեզ» բառը օգտագործելու որևէ պատճառ չկա։ Լավ 
օրինակ կարող է լինել, օրինակ, «Բերքի արտադրությունը Բենինում 2020 թվականին» կամ 
«Տրուխիլյոն արբանյակից», մինչդեռ վատ օրինակներ կարող են լինել «Բերքի արտադրության 
քարտեզը» կամ «Ի՜նչ մանրամասնություն։ Երկնքից պատկերը ցույց է տալիս մեր քաղաքի բոլոր 
փողոցները։ Կարո՞ղ եք գտնել ձեր տունը»։ 
Եթե վերնագիրը չափազանց երկար է, լավ գաղափար է այն բաժանել, որպեսզի այն ցուցադրվի 
որպես վերնագիր և ենթավերնագիր։ Այդ դեպքում վերնագիրը ընթերցողին մոտավոր 
պատկերացում է տալիս քարտեզի թեմայի մասին, իսկ ենթավերնագիրն ավելի 
մանրամասնորեն է ներկայացնում թեման։ Թվային դարաշրջանում քարտեզները հաճախ 
ներկայացվում են որպես վեբ էջեր։ Այդ դեպքում քարտեզի վերնագիրը կարող է ցուցադրվել 
որպես սովորական էջի վերնագիր վեբ զննարկիչում։ 



 
Կարճ վերնագիրը մոտավոր պատկերացում է տալիս քարտեզի թեմայի մասին։ Այն ավելի 
մանրամասն նշված է ենթավերնագրում։ 
 

 
Ինտերակտիվ թվային քարտեզ, որը ներկայացված է որպես վեբ էջ՝ վերնագրով, որը ընդգծված է։ 
 
Մինչ վերնագիրը բացատրում է, թե ինչ է ցուցադրվում քարտեզում, լեգենդը բացատրում է, թե 
ինչպես է այն ցուցադրվում: Քարտեզների, տեքստային բացատրությունների և քարտեզի 
խորհրդանիշների միջոցով ընթերցողը պետք է հասկանա քարտեզի վրա տեսանելի ամբողջ 
բովանդակությունը: Լեգենդի օգտագործման միջոցով ընթերցողը, ի վերջո, կկարողանա 



կարդալ քարտեզը և հասկանալ այն: Սովորաբար, չկա որևէ լավ պատճառ լեգենդը վերնագրելու 
«Լեգենդ» բառով:

 
Օրինակելի քարտեզը պարունակում է երեք լեգենդ, քանի որ այն ցուցադրում է երեք տեսակի 
տեղեկատվություն՝ ա) յուրաքանչյուր կուսակցության զբաղեցրած ավագանու տեղերի 
հարաբերակցությունը՝ պատկերված շրջանագծի կոտորակով (գրաֆիկ), բ) քաղաքային խորհրդի 
չափը՝ տեղերի քանակով, որը ներկայացված է շրջանագծի չափսով (գրաֆիկ) և գ) գրաֆիկներում 
որոշակի կուսակցություններ ներկայացված են իրենց համապատասխան գույնով։ 
 
Տպվածքը քարտեզի հեղինակի, ստեղծման ամսաթվի, քարտեզի տարածական տվյալների 
աղբյուրի, հեղինակային իրավունքի և այլնի համառոտ նկարագրությունն է: Թվային աշխարհում 
տպվածքը սովորաբար փոխարինվում է մետատվյալների գրառումներով: 
 



 
Օրինակելի քարտեզի տպագրությունը բավականին առատաձեռն է։ 
 
Քարտեզի մասշտաբը քարտեզի վրա հեռավորության և երկրի մակերևույթի վրա 
համապատասխան հեռավորության հարաբերությունն է։ Մասշտաբը կարող է ներկայացվել 
թվային արժեքով (օրինակ՝ 1:10 000) կամ գրաֆիկական մասշտաբի սյունակով։ Հազվադեպ այն 
կարող է նկարագրվել բառերով։ Մասշտաբը և հյուսիսային նետը կարող են բաց թողնվել, եթե 
քարտեզի վրա առկա է աշխարհագրական ցանց։ Թվային մասշտաբը նույնպես հարմար չէ 
մեծապես աղավաղված քարտեզների համար (տե՛ս «Քարտեզի պրոյեկցիաներ և 
կոորդինատային համակարգեր» դասախոսությունը)։ 
 

 



Օրինակ քարտեզի վրա մասշտաբը պատկերված է գրաֆիկական սյունակի տեսքով։ 
Ինչպես նշվեց «Քարտեզագրության պատմություն» դասախոսության մեջ, քարտեզների 
կողմնորոշումը զարգացել է։ Այսօր մենք ընդհանուր առմամբ կարող ենք տեսնել երկու 
կողմնորոշում. 

⚫ Դեպի հյուսիս կամ 
⚫ դիտողի ուղղությամբ։ 

Առաջինը տպագիր քարտեզների ամենատարածված կողմնորոշումն է, մինչդեռ երկրորդը 
հանրաճանաչ տարբերակ է թվային ինտերակտիվ քարտեզների համար՝ ձեռքի սարքերում, 
ինչպիսիք են բջջային հեռախոսները կամ խելացի ժամացույցները: Հատկապես այն դեպքում, 
երբ քարտեզը ստատիկ է (տպագիր), հյուսիսային նետը կարևոր տարր է, քանի որ այն օգնում է 
ընթերցողին կողմնորոշել քարտեզը այնպիսի ուղղությամբ, որը համապատասխանում է 
շրջապատող աշխարհին: Հյուսիսային նետը կարող է ցուցադրվել տարբեր ձևերով՝ պարզ նետից 
մինչև ավելի բարդ խորհրդանիշներ: Այն կարող է ուղեկցվել «N» տառով կամ «հյուսիս» բառով: 
Որոշ քարտեզներ չեն պարունակում հյուսիսային նետ, երբ դրանք ցուցադրում են ամբողջ 
աշխարհը կամ մայրցամաքը, որը, ենթադրաբար, հայտնի կլինի ցանկացած պոտենցիալ 
ընթերցողի համար, հատկապես, երբ ստանդարտ կողմնորոշման մեջ հյուսիսը վերևում է: Նման 
դեպքերում հյուսիսային նետը համարվում է ավելորդ: 

 
Հյուսիսային նետի օրինակ։ 
 
Բացի այդ, քարտեզի դասավորությունը կարող է հարստացվել այլ կոմպոզիցիոն տարրերով, 
ինչպիսիք են պատկերները, գծապատկերները, տեքստերը, ներդիր քարտեզները և այլն։ 



 
Այս քարտեզն ունի մեկ լրացուցիչ կոմպոզիցիոն տարր՝ թեմային վերաբերող նկարազարդում 
(պատկեր / լոգո): 
 
Քարտեզի պատկերն ինքնին սովորաբար բաղկացած է տարբեր տարրերից՝ պիտակներ, 
ծանոթագրություններ, խորհրդանիշներ: Քարտեզում օգտագործվող բոլոր խորհրդանիշների, 
նշանների և գույների ամբողջությունը կոչվում է քարտեզի խորհրդանիշ և բացատրվում է 
քարտեզի լեգենդի միջոցով: 

Առաջադրանք 

Համապատասխանեցրեք տարրը դրա գրաֆիկական ներկայացման հետ 

● վերնագիր 

● մասշտաբ 

● լեգենդ 

● հյուսիսային սլաք 

● տպվածք 

Քարտեզագրականպրոյեկցիաներ և կոորդինատային 
համակարգեր 

Քարտեզագրական պրոյեկցիան Երկրի գնդաձև ձևը հարթ մակերևույթի վրա ցուցադրելու 
տեխնիկա է: Դա Երկրի եռաչափ ձևի երկչափ ձևի փոխակերպումն է: Կան անվերջ 



տարբերակներ, թե ինչպես կարող է քարտեզային պրոյեկցիան Երկրի մակերևույթը պրոյեկտել 
հարթության վրա: Յուրաքանչյուր քարտեզային պրոյեկցիա պետք է մեծացնի կամ նվազեցնի 
որոշ բնութագրեր, ներառյալ չափը, ձևը, հեռավորությունը, ուղղությունը և/կամ մասշտաբը: 
 
Քարտեզները բնույթով ներառում են աղավաղումներ, քանի որ անհնար է կատարելապես բացել 
եռաչափ գլոբուսի մակերեսը երկչափ հարթության վրա: Երբ գլոբուսը պրոյեկտվում է հարթ 
մակերեսի վրա, քարտեզի որոշ ասպեկտներ պետք է աղավաղվեն, լինի դա ձևը, մակերեսը, 
հեռավորությունը, թե ուղղությունը: Քարտեզի տարբեր պրոյեկցիաները պահպանում են 
տարբեր չափանիշներ՝ համապատասխանեցնելով որոշակի նպատակների: Այնուամենայնիվ, ոչ 
մի պրոյեկցիա չի կարող միաժամանակ պահպանել այս բոլոր հատկությունները, այդ իսկ 
պատճառով օգտագործվում են տարբեր պրոյեկցիաներ՝ կախված քարտեզի նախատեսված 
նպատակից: 
 
There are three main groups of projections depending on a property they preserve: 

⚫ Conformal projections (like the Mercator projection) preserve angles and shapes locally, 
making them useful for navigation. 

⚫ Equal-area projections (like the Mollweide projection) maintain area accuracy, ensuring that 
the relative size of regions is correct. 

⚫ Equidistant projections (like Plate carée) preserve distances along certain lines. 
Կախված պահպանվող հատկությունից՝ կան պրոյեկցիաների երեք հիմնական խմբեր՝ 

Կոնֆորմ պրոյեկցիաները (ինչպես Մերկատորի պրոյեկցիան) տեղական մակարդակով 
պահպանում են անկյուններն ու ձևերը, ինչը դրանք օգտակար է դարձնում նավարկության 
համար։ 

Հավասար մակերեսով պրոյեկցիաները (ինչպես Մոլվեյդի պրոյեկցիան) պահպանում են 
մակերեսի ճշգրտությունը՝ ապահովելով, որ շրջանների հարաբերական չափը ճիշտ է։ 

Հավասարհեռ պրոյեկցիաները (ինչպես Պլատե կարեը) պահպանում են հեռավորությունները 
որոշակի գծերի երկայնքով։ 
 
Բացի այդ, քարտեզագրական պրոյեկցիան կարող է կառուցվել այնպես, որ վերը նշված 
հատկություններից ոչ մեկը չպահպանվի, բայց այս բոլորի աղավաղումները որոշ չափով 
նվազագույնի հասցվեն։ Սրանք կոչվում են փոխզիջումային պրոյեկցիաներ։ 
 
 



 
Քարտեզի որոշ տարածված պրոյեկցիաներ / Մաքսիմիլիան Դյորբեկեր, CC BY-SA 3.0. 
 
 
Քարտեզի վրա մի քանի տեղերում գծելիս ֆիքսված տրամագիծ ունեցող շրջանագծի վրա 
կարելի է դիտարկել որոշակի պրոյեկցիայի աղավաղման ձևը։ Նման շրջանագիծը կոչվում է 



Tissot-ի ինդիկատրիքս։ Կոնֆորմալ պրոյեկցիաների դեպքում Tissot-ի ինդիկատրիքսը մնում է 
շրջան, բայց դրա չափը քարտեզի վրա փոփոխական է։ Հավասար մակերեսով և հավասարահեռ 
պրոյեկցիաների դեպքում Tissot-ի ինդիկատրիքսը որոշակի տեղերում կարող է շրջան լինել, բայց 
մեծ մասամբ աղավաղվում է մինչև էլիպսիս։

 
Մերկատորի պրոյեկցիան Տիսոյի ինդիկատրիքսով. https://map-projections.net/tissot.php 
 
Կոորդինատային համակարգը մեթոդ է, որն օգտագործվում է տարածության մեջ կետի ճշգրիտ 
դիրքը որոշելու համար՝ օգտագործելով կոորդինատներ կոչվող թվեր: Պարզ ասած, այն 
յուրաքանչյուր կետին վերագրում է արժեքների մի շարք (սովորաբար նշվում են որպես «x», «y» 
և այլն), որոնք օգնում են մեզ որոշել, թե որտեղ է գտնվում ինչ-որ բան: Օրինակ, երկչափ 
տարածությունում «x» կոորդինատը ցույց է տալիս, թե որքան հեռու է կետը ձախ կամ աջ, իսկ 
«y» կոորդինատը՝ որքան մոտ կամ հեռու: 
 
Տարածական ռեֆերենս համակարգը (ՏՀՀ) կամ կոորդինատային հղման համակարգը (ԿՀՀ) մի 
շրջանակ է, որն օգտագործվում է Երկրի մակերևույթի վրա տեղանքները որպես կոորդինատներ 
ճշգրիտ չափելու համար: Հատուկ ՏՀՀ սպեցիֆիկացիան ներառում է Երկրի էլիպսոիդի, 
հորիզոնական տվյալի, քարտեզային պրոյեկցիայի, սկզբնակետի և չափման միավորի 
ընտրություն: Քանի որ Երկրի մակերևույթը հարթության վրա պրոյեկցիայի 
հնարավորությունները անվերջ են, տարածական ռեֆերենս համակարգը սահմանելու անվերջ 



եղանակներ կան: Հազարավոր տարբեր ՏՀՀ-ներ են սահմանվել ամբողջ աշխարհում կամ 
որոշակի տարածաշրջաններում և տարբեր նպատակներով օգտագործելու համար: Հետևաբար, 
հաճախ անհրաժեշտ են լինում տարբեր ՏՀՀ-ների միջև փոխակերպումներ:. 
 
Մենք կարող ենք տարածական ռեֆերենս համակարգերը բաժանել երկու խմբի՝ կախված 
նրանից, թե դրանք աշխատում են աշխարհագրական (գնդաձև) կոորդինատներով, թե՞ 
աշխատում են պրոյեկտվող տարածության մեջ՝ կարտեզյան կոորդինատներով: 
Աշխարհագրական կոորդինատային համակարգը Երկիրը ներկայացնում է որպես կատարյալ 
գունդ, և Երկրի մակերևույթի վրա ցանկացած վայր կարող է նկարագրվել երկու թվերով, որոնք 
նշանակվում են հունական λ և φ տառերով: λ-ն կոչվում է երկայնություն, իսկ φ-ն՝ լայնություն: 
Երկայնությունն ու լայնությունը աստիճաններով անկյուններ են և կարող են ընդունել միայն 
որոշակի արժեքներ: Երկայնության արժեքները սահմանափակված են -180-ից մինչև 180, 
մինչդեռ լայնության արժեքները սահմանափակված են -90-ից մինչև 90: Այս ներկայացման մեջ 
բացասական երկայնությունը ներկայացնում է արևմտյան կիսագունդը, իսկ դրական 
երկայնությունը՝ արևելյան կիսագունդը: Նմանապես, բացասական լայնությունը ներկայացնում 
է հարավային կիսագունդը, իսկ դրական լայնությունը՝ հյուսիսային կիսագունդը: 
Այլընտրանքորեն, կիսագունդը կարող է նշանակվել մեծ տառով՝ արժեքից հետո, օրինակ՝ 49° 
հյուսիսային լայնությունը նշանակում է 49 աստիճան հյուսիսային լայնություն, կամ 15° 
հարավային լայնությունը նշանակում է 15 աստիճան հարավային լայնություն: Գլխավոր 
միջօրեականի և հասարակածի հատույթի վրա գտնվող կետը չի գտնվում կիսագնդերից ոչ մեկի 
վրա, և նրա աշխարհագրական կոորդինատները [0,0] են: Այս կետը տեսականորեն կարող է լինել 
ցանկացած վայրում, բայց ամենատարածված աշխարհագրական կոորդինատային 
համակարգում՝ WGS84-ում, այն իրականում գտնվում է Ատլանտյան օվկիանոսի ներսում, 
հետևաբար այն չի մատնանշում որևէ հատուկ վայր։ 
 
Հաստատուն երկայնություն ունեցող մեծ շրջանագիծը կոչվում է միջօրեական։ Առաջնային 
միջօրեականը 0-ի հավասար երկայնություն ունեցող միջօրեական է։ Առավել հայտնի է Գրինվիչի 
առաջնային միջօրեականը, սակայն պատմականորեն և նույնիսկ այսօր օգտագործվել են այլ 
շրջանագծեր։ 0-ի հավասար լայնություն ունեցող մեծ շրջանագիծը հասարակած է։ 
Հասարակածին զուգահեռ շրջանագծերը կոչվում են զուգահեռականներ կամ լայնության 

շրջանագծեր։  
Երկիրը որպես գունդ՝ կապույտ գույնով մերիդիաններով և զուգահեռականներով, հասարակածը՝ 
կարմիր գծով, իսկ լայնության և երկայնության անկյունները՝ սև գույնով։ 



 
Աշխարհագրական կոորդինատային համակարգով ամենատարածված SRS-ը WGS84-ն է, որը 
Համաշխարհային գեոդեզիական համակարգի ստանդարտի իրականացումն է։ 
 
Մինչ աշխարհագրական կոորդինատային համակարգը սահմանում է գնդաձև մակերևույթի 
վրա գտնվող դիրքերը, կարտեզյան կոորդինատային համակարգը (հայտնի է նաև որպես 
պրոյեկտված կոորդինատային համակարգ) ներկայացնում է հարթ, երկչափ մակերևույթի վրա 
գտնվող դիրքերը։ Երկրի մակերևույթը (կամ դրա մի մասը) պրոյեկտվում է հարթության վրա՝ 
օգտագործելով քարտեզի պրոյեկցիաներից մեկը։ Կարտեզյան կոորդինատային համակարգերի 
մեծ մասը հիմնված է Մերկատորի պրոյեկցիայի վրա, ինչպես UTM-ը (Universal Transverse 
Mercator) կամ Web Mercator-ը։ Նույնիսկ Պուլկովոյի 1942 թվականի համակարգը կարտեզյան 
կոորդինատային համակարգ է, որն օգտագործում է Գաուս-Կրյուգերի պրոյեկցիան, որը 
նույնպես Մերկատորի պրոյեկցիայի տարբերակ է։ 
 
Կոորդինատային համակարգերը (ինչպես աշխարհագրական, այնպես էլ կարտեզյան), 
պրոյեկցիաները և փոխադարձ ձևափոխությունները առանց շփոթության նույնականացնելու 
համար գոյություն ունի EPSG անունով եզակի տվյալների բազա: Այն հղում է կատարում բոլոր 
տարածված կոորդինատային համակարգերին, պրոյեկցիաներին և այլն՝ «EPSG:» տողի միջոցով, 
որին հաջորդում է թվային կոդ: Օրինակ՝ WGS84 համակարգն ունի EPSG կոդ՝ EPSG:4326, մինչդեռ 
Web Mercator-ը՝ EPSG:3857 կոդ, իսկ Pulkovo 1942-ը՝ EPSG:4284 կոդ: Այս կոդերն օգտագործվում 
են կոորդինատային համակարգերը աշխարհագրական տեղեկատվական համակարգերում 
(ԱՏՀ), ինչպես նաև այլուր նույնականացնելու համար: 
 

Առաջադրանք 

Համապատասխանեցրեք պրոյեկցիան դրա նկարագրության հետ 

 
⚫ Պահպանում է անկյունները, աղավաղում չափերը 

 



⚫ Պահպանում է չափերը, աղավաղում երկարությունները 

 

Տարածական տվյալների ձեռքբերման մեթոդներ 

Բոլոր տարածական տվյալների ձեռքբերման մեթոդներից, գետնի հետազոտությունն ունի 
ամենաերկար պատմությունը: Ինչպես նշվել է «Քարտեզագրման պատմություն» գլխում, Երկրի 
առաջին չափումները ներառում էին ոչ այնքան հեռավոր վայրերի միջև հեռավորությունների 
չափում: Հեղափոխական չափումը կատարել է Կյուրենացի Էրատոսթենեսը մ.թ.ա. 3-րդ դարում: 
Էրատոսթենեսն օգտագործել է միայն այդ ժամանակ հասանելի պարզունակ գործիքներ՝ գնոմոն 
և անիվ: Գնոմոնը պարզ սյուն է, որը տեղադրված է Երկրի մակերեսին ուղղահայաց: Չափելով 
Էրատոսթենեսի սայլի անիվի պտույտները և գնոմոնի կողմից երկու տարբեր վայրերում գցված 
ստվերի երկարությունը, Էրատոսթենեսը կարողացավ բավականին ճշգրիտ հաշվարկել Երկրի 
շրջագիծը ավելի քան 2200 տարի առաջ: Նրա մոտեցումը ոգեշնչեց շատ ավելի ուշ չափումներ 
կատարել 16-րդ դարի Ֆրանսիայում: 
 
Երբ հորինվեցին ավելի լավ և ավելի ճշգրիտ գործիքներ, բարելավվեցին նաև Երկրի չափումները: 
18-րդ դարում Յոզեֆ Լիսգանգը օգտագործեց աստղադիտակ՝ դիտարկելի հորիզոնում գտնվող 
օբյեկտների միջև անկյունները չափելու համար: Նաև մի քանի վայրերում հեռավորությունը 
չափելով՝ նա կարողացավ կառուցել հայտնի չափերի երևակայական եռանկյունիներ: Այս 
եռանկյունիների գագաթները լավ նույնականացված վայրեր էին բլուրների կամ շինությունների 
վրա, ինչպիսին է տաճարի աշտարակը: Սկզբունքորեն, նույն մեթոդը օգտագործվում է մինչև 
այսօր: Թեոդոլիտ անունով սարքը անկյունները չափելու հիմնական գործիք էր 19-րդ և 20-րդ 
դարերում և մինչ օրս օգտագործվում է շինարարական աշխատանքների պարզ 
առաջադրանքների համար: Վերջերս թեոդոլիտները փոխարինվեցին էլեկտրոնային ընդհանուր 
կայաններով, որոնք միաժամանակ չափում են և՛ անկյունները, և՛ հեռավորությունները: Այսօր 
ընդհանուր կայանները ռոբոտացված են, ինչը նշանակում է, որ դրանք կարող են պտտվել 
ցանկալի ուղղությամբ հեռակառավարման վահանակի միջոցով: Դրանք նաև հաճախ 
համակցվում են GNSS սարքավորումների հետ՝ դաշտում առավել ճշգրիտ արդյունքները 
հաշվարկելու համար՝ առանց հետագա հետմշակման, ինչը կարևոր է շինհրապարակներում 
սահուն աշխատանքի համար: 
 
Գլոբալ նավիգացիոն արբանյակային համակարգերը (GNSS) աշխատում են՝ արբանյակային 
ազդանշանների միջոցով որոշելով Երկրի վրա ընդունիչի ճշգրիտ դիրքը: GNSS-ի հիմնական 
սկզբունքը հիմնված է ազդանշանի արբանյակից ընդունիչ հասնելու համար անհրաժեշտ 
ժամանակի չափման վրա: Յուրաքանչյուր GNSS արբանյակ անընդհատ փոխանցում է 
ազդանշաններ, որոնք ներառում են արբանյակի դիրքը և ազդանշանի ուղարկման ճշգրիտ 
ժամանակը: Երկրի վրա գտնվող ընդունիչը գրանցում է ազդանշանի ստացման ժամանակը: 
Հաշվարկելով ազդանշանի արձակման և ստացման ժամանակների միջև ժամանակային 
տարբերությունը՝ ընդունիչը կարող է որոշել իր հեռավորությունը այդ արբանյակից: 

Քանի որ ընդունիչը գիտի միայն իր հեռավորությունը արբանյակից (և ոչ թե ուղղությունը), այն 
կարող է գտնվել այդ շառավղով գնդի ցանկացած վայրում։ Դրա գտնվելու վայրը ճշգրիտ որոշելու 
համար ընդունիչին անհրաժեշտ են ազդանշաններ առնվազն չորս արբանյակներից։ Երբ այս 
արբանյակներից ստացված տվյալները միավորվում են, ընդունիչը հաշվարկում է իր դիրքը 
եռակողմանի գործընթացի միջոցով։ Մի քանի արբանյակներից ստացված գնդերի հատումը 
թույլ է տալիս ընդունիչին որոշել իր ճշգրիտ դիրքը երեք չափումներում (լայնություն, 
երկայնություն և բարձրություն)։ Այս գործընթացը հաշվի է առնում ժամանակային 
անհամապատասխանությունները՝ լուծելով և՛ ընդունիչի դիրքը, և՛ ընդունիչի ժամացույցի 
սխալը, ինչը GNSS-ը դարձնում է գլոբալ դիրքորոշման ճշգրիտ և հուսալի մեթոդ։ 



Առաջին GNSS համակարգը ամերիկյան ռազմական NAVSTAR GPS կամ կարճ՝ պարզապես GPS 
համակարգն էր։ Դրա դիրքորոշման ճշգրտությունը սկզբում անհասկանալի էր քաղաքացիական 
օգտագործման համար, իսկ մետրից ցածր ճշգրտությամբ տեղորոշումը հասանելի էր միայն 
ռազմական կիրառությունների համար։ Քաղաքացիական ընդունիչները կարող էին որոշել դրա 
տեղորոշումը միայն մի քանի մետրի ճշգրտությամբ։ NAVSTAR GPS-ի այս խճճվածությունը 
վերացվեց 2000 թվականին։ Հանրային գեոդեզիական օգտատերերի համար նախատեսված 
GNSS ընդունիչների զարգացման հետ մեկտեղ հնարավոր է դարձել մի քանի սանտիմետրի 
դիրքորոշման ճշգրտություն։ Սա շնորհիվ GNSS ալիքի փուլային չափումների օգտագործման 
մոտեցման։ 2024 թվականի դրությամբ ամբողջ աշխարհում լիովին գործում են չորս GNSS 
համակարգեր։ Ամերիկյան NAVSTAR GPS-ից բացի, դա ռուսական GLONASS համակարգն է, 
չինական Beidou համակարգը և եվրոպական Galileo համակարգը։ Ճապոնիան կառուցում է GNSS 
համակարգ, որը հատուկ հարմար է Արևելյան Ասիայի տարածաշրջանի համար։ Այս GNSS 
համակարգերը տարբերվում են ոչ միայն այն երկրում, որտեղ գտնվում է դրանց շահագործման 
կենտրոնը և որ կառավարությունն է ֆինանսավորում դրանց գործունեությունը, այլև 
տեխնիկական ասպեկտներով, ինչպիսիք են՝ ալիքի փոխանցման հաճախականությունը, Երկրի 
ուղեծրում գտնվող արբանյակների քանակը, բարձրությունը և անկյունը (թեքությունը), 
արբանյակների Երկրի շուրջ պտտման արագությունը, նրանց կողմից փոխանցվող ալիքների 
քանակը և այլն։ 
 
Այն դեպքերում, երբ NAVSTAR GPS ազդանշանը իդեալական չէր կամ պահանջվում էր ավելի մեծ 
ճշգրտություն, մշակվեցին GPS-ի տեղական կատարելագործման համակարգեր, որոնք կոչվում 
էին SBAS համակարգեր: Այս համակարգերից նշանավոր է եվրոպական EGNOS-ը՝ որպես ԵՄ 
սեփական Galileo համակարգի նախորդը: 
 
Ընդհանուր առմամբ, տարածական տեղեկատվության հեռվից ստացումը՝ առանց դիտարկվող 
տարածքի հետ ֆիզիկական շփման, կոչվում է հեռազգացում: Տարածական տվյալների հեռակա 
հավաքագրումը ներառում է օդային լուսանկարչություն, արբանյակային պատկերներ կամ LiDAR 
(լույսի հայտնաբերում և հեռահար չափում) տեխնիկաներ: 
 
Օդանավերից լուսանկարելը պատկանում է հեռազգացման ավելի հին մեթոդներին: Ճշգրիտ 
հետազոտական լուսանկարների ձեռքբերման գործընթացը կոչվում է ֆոտոգրամետրիա: 
Օդային լուսանկարչությունը կարող է ապահովել բարձր լուծաչափով պատկերներ, սակայն մեծ 
տարածքի համար տվյալների հավաքագրումը դանդաղ և թանկ է: Արբանյակային պատկերները 
սովորաբար ապահովում են ավելի վատ լուծաչափ, սակայն կարելի է ծածկել ավելի լայն 
տարածք: Այսօր արբանյակային պատկերները ծածկում են ամբողջ աշխարհը և հաճախ 
օգտագործվում են որպես հիմքեր Google Maps-ի նման հայտնի առցանց քարտեզներում: 
Վերջերս անօդաչու թռչող սարքերը (ԱԹՍ) թույլ են տվել շատ մանրամասն լուսանկարներ անել 
փոքր տարածքից՝ միաժամանակ էժան լինելով: Այս տեխնիկայի միջոցով ստացված 
լուսանկարները կարող են մշակվել օրթոֆոտոների, օրթոֆոտո քարտեզների և նույնիսկ 
տեղանքի եռաչափ մոդելների մեջ: 
 
Օդային, արբանյակային և անօդաչու թռչող սարքերի ֆոտոգրամետրիայից ստացված 
պատկերները պարտադիր չէ, որ արտացոլեն լույսի տեսանելի սպեկտրը, ինչպես դա անում են 
սովորական տեսախցիկները:  Ինֆրակարմիրին մոտ, ինֆրակարմիր և սպեկտրի այլ մասերից 
ստացված տեղեկատվությունը օգտակար է անտառտնտեսության, գյուղատնտեսության և այլ 
ոլորտներում կիրառությունների համար: 
 
LiDAR տեխնիկան հիմնված է լազերով օբյեկտի կամ մակերեսի թիրախավորման վրա: 
Անդրադարձված լույսի կողմից ընդունիչին վերադառնալու ժամանակը հաշվարկվում է 
հեռավորության համար: Քանի որ լազերը կարող է լույսի փունջը մեկ վայրկյանում արձակել 
հազարավոր կետեր, LiDAR-ի ելքը սովորաբար լազերային սարքի և դիտարկվող օբյեկտի կամ 



տեղանքի միջև հեռավորությունների մեծ հավաքածու է: Հետևաբար, հեռավորությունները 
վերածվում են կետերի այն վայրերում, որտեղ լազերային փունջը անդրադարձել է: Այս կետերի 
հավաքածուն կոչվում է կետային ամպ: Լազերային տվյալների հավաքագրման գործընթացը 
կոչվում է լազերային սկանավորում: 
 

Առաջադրանք 

Համապատասխանեցրեք տարածական տվյալների ձեռքբերման տեխնիկան դրա 
նկարագրության հետ՝ 

⚫ Հեռահար զոնդավորում – տարածական տեղեկատվության հեռահար ստացում 
⚫ Լազերային սքանավորում – օբյեկտների կամ տեղանքի մասին ճշգրիտ եռաչափ 

տեղեկատվության ստացում՝ խիտ կետային ամպերի տեսքով 
⚫ Հողային հետազոտություն- անկյունների և հեռավորությունների չափում՝ որոշակի 

կետերով և գծերով օբյեկտները ներկայացնելու համար։ 
⚫ GNSS տեխնիկա – Երկրի վրա ճշգրիտ տեղակայման որոշում՝ բազմաթիվ 

արբանյակներից ազդանշաններ ստանալովUsing Maps 
 
Որակյալ քարտեզները և քարտեզների ճշգրիտ օգտագործումը կարևոր են առօրյա բազմաթիվ 
ոլորտներում, ներառյալ, բայց չսահմանափակվելով դրանով 

⚫ Նավիգացիա և տրանսպորտ. Երթևեկության ուղղությունների, հասարակական 
տրանսպորտի պլանավորման և լոգիստիկայի համար քարտեզները օգնում են 
մարդկանց և ապրանքները արդյունավետորեն հասնել A կետից B կետ: Հիմնական 
նավիգացիայից բացի, տարածական տվյալները և քարտեզի տվյալները կարևոր են 
տրանսպորտի ոլորտում երթևեկության կառավարման և գերբեռնվածության 
կանխատեսման համար: Իրական ժամանակի երթևեկության օրինաչափությունները և 
երթևեկության հոսքի վերաբերյալ պատմական տվյալները վերլուծելով՝ 
տրանսպորտային վարչությունները կարող են բացահայտել գերբեռնվածության թեժ 
կետերը, վերահսկել երթևեկության միջադեպերը և կարգավորել ազդանշանները կամ 
իրականացնել շրջանցիկ ճանապարհներ՝ խցանումները մեղմելու համար: Տարածական 
տվյալները նաև աջակցում են ենթակառուցվածքների պլանավորմանը՝ օգնելով 
պլանավորողներին որոշել, թե որտեղ ավելացնել նոր ճանապարհներ, հեծանվային 
գոտիներ կամ հետիոտնային արահետներ՝ շարժունակությունը բարելավելու և 
քաղաքային տարածքներում ճանապարհորդության ժամանակը կրճատելու համար: 

⚫ Քաղաքային պլանավորում: Քարտեզները օգնում են քաղաքաշինարարներին 
նախագծել ճանապարհների, կանաչ տարածքների և կոմունալ ծառայությունների 
դասավորություններ՝ հողօգտագործումը օպտիմալացնելու և կյանքի որակը 
բարելավելու համար: Քարտեզների քաղաքաշինարարներին օգնելու կոնկրետ օրինակ է 
ջերմային քարտեզների օգտագործումը՝ քաղաքային «ջերմային կղզիները» 
նույնականացնելու համար՝ տարածքներ, որտեղ շենքերը, ճանապարհները և 
ենթակառուցվածքները առաջացնում են ավելի բարձր ջերմաստիճաններ՝ 
սահմանափակ բուսականության պատճառով: Ջերմաստիճանի տվյալները քաղաքի 
քարտեզների վրա համադրելով՝ քաղաքաշինարարները կարող են նշել այն 
թաղամասերը, որոնք կշահեն լրացուցիչ կանաչ տարածքներից, ինչպիսիք են այգիները, 
կանաչ տանիքները կամ ծառապատ փողոցները: Այս քարտեզագրումը ոչ միայն օգնում է 
նվազեցնել տեղական ջերմաստիճանը և բարելավել օդի որակը, այլև բարելավում է 
բնակիչների կյանքի որակը՝ ստեղծելով ավելի զով, ավելի հաճելի տարածքներ հանգստի 
համար և նվազեցնելով մոտակա շենքերում սառեցման համար անհրաժեշտ էներգիայի 
ծախսերը: 

⚫ Աղետների կառավարում. Քարտեզները օգնում են արտակարգ իրավիճակներին 
արձագանքողներին պլանավորել և արձագանքել բնական աղետներին՝ ապահովելով, որ 



նրանք կարողանան հասնել տուժած տարածքներ և արդյունավետորեն բաշխել 
ռեսուրսները: Օրինակ՝ արտակարգ իրավիճակներին արձագանքող ծառայությունների 
կողմից ջրհեղեղի ռիսկի քարտեզների օգտագործումը փոթորիկների սեզոնի 
ընթացքում՝ տարհանումները պլանավորելու և ռեսուրսներ բաշխելու համար: Այս 
քարտեզները, որոնք համատեղում են բարձրության տվյալները, տեղումների 
կանխատեսումները և պատմական ջրհեղեղի օրինաչափությունները, օգնում են 
արձագանքողներին նույնականացնել ջրհեղեղի հավանականություն ունեցող 
տարածքները և հնարավոր հետևանքների ծանրությունը: Բարձր ռիսկի գոտիները 
նշելով՝ արտակարգ իրավիճակների խմբերը կարող են առաջնահերթություն տալ 
տարհանումներին, տեղակայել փրկարարական խմբեր և պաշարներ մոտակայքում, 
ինչպես նաև ապաստարաններ տեղադրել բարձրադիր վայրերում: Արձագանքման 
ընթացքում այս քարտեզները թարմացվում են իրական ժամանակի տվյալներով՝ 
ուղղորդելով խմբերին դեպի ամենաշատ տուժած տարածքները և օգնելով համակարգել 
ռեսուրսների, ինչպիսիք են սնունդը, ջուրը և բժշկական օգնությունը, մատակարարումը: 

⚫ Գյուղատնտեսություն: Ֆերմերներն ու գյուղատնտեսական ընկերությունները 
քարտեզներ են օգտագործում մշակաբույսերի դասավորությունը պլանավորելու, հողի 
որակը կառավարելու և ռեսուրսները, ինչպիսին է ջրի մատչելիությունը, վերահսկելու 
համար: Հատուկ օրինակ է արբանյակային և անօդաչու թռչող սարքերի տվյալներից 
ստեղծված հողի սննդանյութերի քարտեզների օգտագործումը՝ ֆերմերներին օգնելու 
կառավարել մշակաբույսերի դասավորությունը և օպտիմալացնել պարարտանյութերի 
օգտագործումը: Այս քարտեզները ցույց են տալիս սննդանյութերի տարբեր 
մակարդակներ դաշտում, թույլ տալով ֆերմերներին պարարտանյութեր կիրառել միայն 
այնտեղ, որտեղ դրանք անհրաժեշտ են, այլ ոչ թե միատեսակ ամբողջ դաշտում: Այս 
թիրախային մոտեցումը, որը հայտնի է որպես ճշգրիտ գյուղատնտեսություն, 
բարելավում է մշակաբույսերի բերքատվությունը, նվազեցնում է թափոնները և 
նվազագույնի է հասցնում շրջակա միջավայրի վրա ազդեցությունը՝ կանխելով 
սննդանյութերի հոսքը մոտակա ջրային աղբյուրներ: 

⚫ Շրջակա միջավայրի պահպանություն: Քարտեզները կարևոր են վայրի բնության 
բնակավայրերը հետևելու, բնական ռեսուրսները կառավարելու և էկոհամակարգերը 
պաշտպանելու համար պահպանության ջանքերը պլանավորելու համար: Օրինակ՝ GPS 
հետևման տվյալներով ստեղծված միգրացիոն քարտեզներն օգտագործվում են 
կենդանիների տեղաշարժերը, օրինակ՝ աֆրիկյան փղերի տեղաշարժերը վերահսկելու 
համար: Բնապահպանները օգտագործում են այս քարտեզները՝ կարևոր միգրացիոն 
միջանցքներն ու կերակրման վայրերը որոշելու համար, ինչը նրանց թույլ է տալիս 
առաջնահերթություն տալ բնակավայրերի պաշտպանության տարածքներին և ստեղծել 
անվտանգ անցումներ մարդու կողմից փոփոխված լանդշաֆտներով: Այս տվյալները 
կարող են նաև բացահայտել, թե որտեղ են փղերը բախվում սպառնալիքների, ինչպիսիք 
են որսագողությունը կամ բնակավայրերի մասնատումը: Այս միգրացիայի 
օրինաչափությունները հասկանալով՝ պահպանության թիմերը կարող են 
համագործակցել տեղական ինքնակառավարման մարմինների հետ՝ պահպանվող 
տարածքներ նշանակելու, որսագողության դեմ պարեկություններ իրականացնելու և 
վայրի բնության միջանցքներ ստեղծելու համար, որոնք կապում են մասնատված 
բնակավայրերը: 

⚫ Մանրածախ առևտուր և մարքեթինգ: Գործարարները քարտեզներ են օգտագործում 
խանութների համար լավագույն վայրերը գտնելու, հաճախորդների դեմոգրաֆիկ 
տվյալները վերլուծելու և առաքման երթուղիները պլանավորելու համար: Մեկ կոնկրետ 
օրինակ է, թե ինչպես է Starbucks-ը օգտագործում աշխարհագրական տեղեկատվական 
համակարգերը (GIS)՝ խանութների նոր վայրեր ընտրելու համար: Քարտեզները 
շերտավորելով հաճախորդների դեմոգրաֆիկ տվյալներով, ինչպիսիք են եկամտի 
մակարդակը, տարիքային խմբերը և ծախսերի սովորությունները, նրանք 
նույնականացնում են բարձր պոտենցիալ հաճախորդների խտություն և 



համապատասխան գնողունակություն ունեցող տարածքները: GIS-ը նաև օգնում է 
վերլուծել հետիոտնային երթևեկությունը և այլ բիզնեսների, ինչպիսիք են 
գրասենյակային համալիրները կամ համալսարանները, մոտիկությունը, որտեղ սուրճի 
պահանջարկը սովորաբար ավելի բարձր է: 

Վարժություն 1: Հողի սննդանյութերի քարտեզի ստեղծում 

Նպատակ: Օգտագործել հողի սննդանյութերի տվյալները QGIS-ում քարտեզ ստեղծելու համար. 

Քայլերը: 

1. Բեռնել տվյալները: 
 Բացել QGIS-ը և ստեղծել նոր նախագիծ. 
 Անցեք Layer > Add Layer > Add Vector Layer՝ դաշտի սահմանային տվյալները 

(օրինակ՝ shapefile կամ GeoJSON) բեռնելու համար։ 
 Բեռնեք հողի սննդանյութերի տվյալները որպես ռաստրային կամ աղյուսակային 

ֆայլ (օրինակ՝ CSV՝ լայնությամբ, երկայնությամբ և սննդանյութերի 
մակարդակներով): 

2. Պատկերեք դաշտի սահմանները։ 
 Աջ սեղմումով Սեղմեք դաշտի սահմանային շերտի վրա՝ > Properties > Symbology. 
 Ընտրեք հարմար ուրվագծային կամ լցման գույն՝ հեշտ տեսանելիության համար։ 

3. Ստեղծեք հողի սննդանյութերի ռաստեր (եթե տվյալները աղյուսակային են): 
 Օգտագործեք Processing Toolbox > Interpolate Points. 
 Ընտրեք սննդանյութերի սյունը որպես մուտքագրման դաշտ։ 
 Ընտրեք IDW (Inverse Distance Weighted) կամ Kriging որպես ինտերպոլացիայի 

մեթոդ. 
 Պահպանել արդյունքը որպես ռաստրային շերտ 

4. Սննդանյութերի քարտեզի ոճավորումը. 
 Սեղմեք սննդարար նյութերի ռաստերի վրա աջ կոճակով > Properties > Symbology. 
 Ընտրե Singleband pseudocolor. 
 Սահմանեք գունային աստիճանավորում՝ ցածրից բարձր սննդանյութերի արժեքը 

ներկայացնելու համար (օրինակ՝ կարմիր՝ ցածրի համար, կանաչ՝ բարձրի 
համար)). 

 Կարգավորեք լեգենդը՝ սննդանյութերի միջակայքերը հստակ ցույց տալու 
համար։ 

5. Ավելացրեք լեգենդ: 
 Անցեք Project > Layout Manager նոր դասավորություն ստեղծելու համար. 
 Տեղադրեք քարտեզը և լեգենդը օգտագործելով Add Legend գործիքը. 

6. Քարտեզի արտահանում: 
 Պահպանեք դասավորությունը որպես PDF կամ PNG՝ հետագա օգտագործման 

համար. 

 

Վարժություն 2: Zones Պարարտանյութի գոտիների վերլուծություն և որոշում 

Նպատակ: Օգտագործեք սննդանյութերի քարտեզը՝ նպատակային պարարտանյութերի 
կիրառման տարածքները որոշելու համար 

Քայլեր. 

1. Դասակարգեք սննդանյութերի քարտեզը 



 Սեղմեք սննդանյութերի ռաստերի վրա աջ կոճակով > Properties > Symbology. 
 Use Օգտագործեք Classified symbology /դասակարգված խորհրդանշում/՝ 

սննդանյութերի մակարդակները 3-5 միջակայքերում խմբավորելու համար 
(օրինակ՝ շատ ցածր, ցածր, միջին, բարձր, շատ բարձր 

2. Նկարեք պարարտանյութերի գոտիները: 
 Ավելացնել նոր վեկտորային շերտ: 

■ Անցեք Layer > Create Layer > New Shapefile Layer. 
■ Ընտրեք Polygon բազմանկյան երկրաչափական պատկերը։ 

 Օգտագործեք Add Polygon Feature գործիքը պարարտանյութի կարիք ունեցող 
տարածքների շուրջ բազմանկյուններ գծելու համար։ 

3. Նշեք գոտիները: 
 Նոր վեկտորային շերտի վրա սեղմեք աջ կոճակով> Properties > Labels. 
 Միացրեք պիտակավորումը և սահմանեք սննդանյութերի մակարդակի 

միջակայքը որպես պիտակի տեքստ 
4. Արդյունքների արտահանում: 

 Պահպանեք պարարտանյութի գոտու շերտը հետագա վարժություններում 
օգտագործելու համար։ 

 Արտահանել քարտեզի դասավորությունը, որը ցույց է տալիս սննդանյութերի 
գոտիները և առաջարկվող պարարտանյութերի տարածքները: 

Դասընթացի եզրափակիչ առաջադրանք 

1. Համապատասխանեցրեք տերմինը դրա նկարագրությանը 
 

քարտեզ Երկրի մակերևույթի կամ այդ մակերևույթի մի մասի փոքրացված կամ 
պարզեցված պատկեր 

Աշխարագրակ
ան տվյալներ 

Երկրի հետ կապված առանձնահատկություններ կամ երևույթներ 
ներկայացնող տվյալներ 

Լասերային 
սքանավորում 

օբյեկտների կամ տեղանքի մասին ճշգրիտ եռաչափ տեղեկատվության 
ստացում՝ խիտ կետային ամպերի տեսքով 

GNSS տեխնիկա Երկրի վրա ճշգրիտ տեղակայման որոշում՝ բազմաթիվ արբանյակներից 
ազդանշաններ ստանալով 

 
2. Համապատասխանեցրեք պատկերը ամենահարմար նկարագրությանը 



 

Պրոյեկցիա, որը պահպանում է անկյունները, 
բայց աղավաղում է չափերը։ 

 

Քարտեզի լեգենդ 

 

Օրթոֆոտո 



 

Վիճակագրական քարտեզ Pierre C. F. Dupin –ի 
կողմից 

 

Տեղագրական քարտեզ 

 
3. Նայիր  քարտեզին և պատասխանիր հետևյա հարցերին: 

a. Ո՞ր էկոտարածաշրջանն է ներկայացված դեղին գույնով: (Մեծ հարթավայրեր, 
Արկտիկական Կորդիլերաներ, Արևադարձային չոր անտառներ) 

b. Ո՞ր էկոշրջան(ներ)ն են առավել ձգվում դեպի հյուսիս: (Արկտիկական 
Կորդիլերա, Տունդրա, Հուդզոնի հարթավայր): 

c. Մայրցամաքի որ մասում կարելի է հանդիպել արևադարձային չոր 
անտառների: (հարավ, հյուսիս, արևմուտք): 



 
Աղբյուր: Iva Brunec via X.com 


